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COPYRIGHT
This manual is the property of Given® Imaging Limited. and may not be transferred or reproduced in any form without
the written permission of Given® Imaging Limited.  This manual is protected under the copyright laws of Israel.
Copyright © 2001, Given® Imaging Limited. All rights reserved.

TRADEMARKS
The RAPID™ Application and the M2A™ Capsule are trademarks of Given® Imaging Limited. Given®  is a
registered trademark of Given® Imaging Limited.
MS Windows is a registered trademark of Microsoft Corporation.

WARRANTY
Given® Imaging Limited warrants that the components of the Given® Diagnostic Imaging System have been
designed, manufactured, packaged and tested with reasonable care and is free from any type of defects. Given®
Imaging Limited is not liable for any incidental or consequential loss, damage, or expense arising , directly or
indirectly , from the use of the Given® Diagnostic Imaging System. Given® Imaging Limited obligation as implied in
this warranty, is to repair or replace any component of the system. Customers are liable for all matters beyond Given®
Imaging Limited control such as handling, storage, cleaning, misuse, treatment and diagnosis. This warranty is in lieu
of and excludes all other warranties whether expressed or implied warranties of merchantabilty or fitness.

FCC ID#=O8PGIVENIMAGING
This device complies with Part 15 of the FCC rules. Operation is subject to the following

two conditions: (1) this device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired

operation.

Note:
Changes or modifications not expressly approved by Given®
Imaging Limited could void authority to operate the Given®
Imaging Diagnostic System.

US Federal Law restricts this device to sale by or on the order of a physician
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Chapter One

Given® Diagnostic Imaging
System

System OverviewSystem OverviewSystem OverviewSystem Overview
The Given® Diagnostic Imaging System is an easy-to-use
non-invasive and ambulatory device that permits
visualization of the patient’s gastrointestinal tract, especially
the small intestine.

The system is comprised of three main components:

•  M2A™ Capsule

•  Data Recorder Set

•  RAPID™ Application Software and Workstation
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The M2A™ Capsule acquires pictures of the gastrointestinal
tract and transmits them to the Data Recorder. The Data
Recorder stores the pictures and downloads the data to the
RAPID™ Workstation. On the workstation, the data is
processed into a colorful, easy-to-control Patient RAPID™
Report (PRR) video movie. You can view the PRR movie to
analyze and make diagnoses about any abnormalities in the
gastrointestinal tract.

Even though the Given® Diagnostic Imaging System
performs the complicated tasks of filming the digestive
activity and image and other data processing, it is very easy
to use, eliminating the need for sedation. Moreover, it does
not require the patient to undergo an invasive and
uncomfortable procedure, and assists in the  early detection
of pathologies of the small bowel.

RAPID™
Workstation

Data
Recorder

Sensor Array

M2A™
Capsule

Waist Belt
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M2A™ Capsule
The ingestible imaging M2A™ Capsule acquires video
images while traveling along the patient’s gastrointestinal
tract. The M2A™ Capsule is propelled by peristalsis through
the gastrointestinal tract and does not require a pushing force
to propel it through the bowel.

The M2A™ Capsule contains a miniscule color video camera
with a flash (CMOS Imager), a watch battery, a transmitter,
and an antenna, all of which are embedded within a regular
size ingestible capsule. The Capsule is a two-dome, cylinder
shaped unit having an outer diameter of 11mm and length of
26mm, and it is made out of biocompatible plastic.

The M2A™ Capsule is provided ready for ingestion, stored
in a blister, a hermetically sealed magnetic packaging. The
proximity of a magnet in the blister inactivates the M2A™
Capsule.

Each M2A™ Capsule comes with a holder that covers the
Capsule’s imager and enables you to handle the M2A™
Capsule until ingestion.

M2A™
Capsule

M2A™
Capsule with
holder

M2A™
Capsule with
blister
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The M2A™ Capsule starts immediately after its removal
from the proximity of the magnet in the blister and the
consequent closing of the magnetic switch in the capsule.
After a brief (less than one minute) test by the physician to
verify that the capsule is active, the capsule is ingested by the
patient. While active, the capsule transmits images at a rate of
2 images per second. For each image, an illuminating light
flash of 100ms is applied with the illuminating LEDs. When
the battery power is depleted, the transmitter disables the
imager and switches the M2A™ Capsule off.

For specification and technical parameters of the M2A™
Capsule, refer to System Specifications on page 15. For
Indications and Contraindications, refer to Indications and
Contraindications on page 9.
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Data Recorder Set
The Data Recorder Set includes the following items:

•  Data Recorder

•  Sensor Array

•  Battery Pack

•  Waist Belt

•  Battery Charger

Data Recorder
The Data Recorder is an external receiving/recording unit
that receives the data transmitted by the M2A™ Capsule.

The Data Recorder is a portable Walkman™-size battery-
operated unit attached to a waist belt worn by the patient
during the examination.

The Data Recorder is comprised of a receiver, processor
module and a hard disk drive for storing the data. All of these
components are encased in a plastic (ABS) box.

The Data Recorder is ready for operation once you connect
the Battery Pack and the Sensor Array to the Data Recorder.
However, the actual recording requires that the input signal
cross a threshold. A green blinking LED indicates whether
and when the Data Recorder records data.
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Sensor Array

The Sensor Array receives data from the M2A™ Capsule and
transfers it to the Data Recorder. It is comprised of 8 identical
sensors. Each sensor is connected to the Data Recorder
module by a flexible coaxial cable. The sensor is built of
flexible printed circuit board (PCB) and is attached to the
skin by means of disposable, medical adhesive pads.

Battery Pack
The Battery Pack is the power supply of the Data Recorder. It
includes 8 Nickel-metal 6V rechargeable batteries. The
Battery Pack is disconnected from the Data Recorder at the
end of each examination and is connected to the Charger
supplied with the Given® Diagnostic Imaging System to be
ready for the next procedure.

Waist Belt
The Waist Belt is an adjustable waist-belt that includes two
pouches to hold the Data Recorder and the Battery Pack. The
belt also includes a flap to hold the excess Battery Pack-Data
Recorder cable.  The Waist Belt also contains shielding that
facilitates FCC compliance.  The Waist Belt must therefore
be worn at all times while the M2A™ Capsule is active
inside the patient.

Battery Charger

The Battery Charger charges the Battery Pack and should be
used after each examination.
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For specification and technical parameters of the Data
Recorder, refer to System Specifications on page 15.

Sensor Array

Sensor Array
cable

Data Recorder

M2A™
Capsule

M2A™
Capsule
with
holder

Battery
Pack
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RAPID™ Application Software and Workstaion
The RAPID™ Workstation is a modified standard personal
computer designed for storage, presentation and processing
of the acquired images and for generating reports.
The RAPID™ (Reporting and Processing of Images and
Data) Application Software is a program installed on the
Workstation, which performs various tasks as the following
table lists:

Task Explanation

Recorder
communication

Enables Recorder initialization and data download
from the Recorder to the workstation.

Data conversion Handles various data formats.
Image processing Performs the image processing algorithm and

condenses up to 10 hours of filming into a 30 minute
movie.

Video display Displays the Patient RAPID Report (PRR).

Thumbnail display Enables copying individual images from the movie, to
display, annotate, print and save them.

AVI movie Creates a short movie of the selected image and its
adjacent images.

Timebar display Shows the exact time of the current image displayed in
the Video section.

Patient Check-In Enables etntry and storage of all patient information.

Note:
To use the RAPID™ Application, you should be familiar with
Microsoft Windows® interface and capable of using a mouse.



Overview

Given Imaging Ltd. 9

Indications and ContraindicationsIndications and ContraindicationsIndications and ContraindicationsIndications and Contraindications

Indications
The Given® Diagnostic Imaging System is intended for the
detection of pathologies as an adjunctive tool in the diagnosis
of small bowel gastrointestinal disorders and diseases.

The Given® Diagnostic Imaging System may be used in
hospitals, outpatient clinics and physician offices. After the
M2A™ Capsule is ingested the patient is not restricted to a
medical environment.

Contraindications
The M2A™ Capsule is contraindicated for use under the
following conditions:

•  In patients suspected to suffer from intestinal obstruction
based on the clinical picture or pre-procedure testing and
profile.

•  In patients with cardiac pacemakers or other implanted
electromedical devices.

•  During pregnancy.

•  With patients who have known or suspected
gastrointestinal obstruction or strictures. Prior abdominal
surgery is a relative contraindication to the use of the
M2A™ Capsule.
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WarningsWarningsWarningsWarnings
A Warning indicates a condition that may endanger the
patient or the operator.

Warnings

•  The M2A™ Capsule should be used only after consulting
a physician.

•  A thorough understanding of the technical principles,
clinical applications and risks associated with the Given®
Diagnostic Imaging System is necessary before using this
product. Read the entire manual before using the system
for the first time.

•  To prevent the patient from being exposed to unforeseen
risks during passage of the M2A™ Capsule, make sure
the patient thoroughly understands the procedure, and
provide the patient with a copy of the Patient Instructions
for Undergoing Capsule Endoscopy. (You can print it
from the RAPID™ Application.)

•  If there is reasonable doubt concerning the integrity of
the M2A™ Capsule due to dropping, biting or any other
eventuality, it should not be used until consulting with an
authorized Given® representative and should be
deactivated by returning it in its holder into its blister.

•  Do not use an M2A™ Capsule after its expiration date.

•  Instruct the patient to avoid biting the M2A™ Capsule
prior to swallowing.

•  After ingesting the M2A™ Capsule and until it is
excreted, the patient should not be near any source of
powerful electromagnetic fields such as one created near
an MRI device.
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•  The patient should be instructed to contact the physician
immediately if after ingesting the M2A™ Capsule he/she
has any abdominal pain, nausea or vomiting.

•  The patient should be instructed to keep the Data
Recorder Waist Belt on throughout the procedure, for a
minimum of 8 hours.

•  This M2A™ Capsule must be stored in a safe place out
of the reach of children and/or infants.

•  If contrary to instructions a patient ingested two capsules,
he/she should be instructed to contact the physician
immediately.

•  If a child has accidentally swallowed an unused or spent
M2A™ Capsule, the child should be brought
immediately to a hospital.

•  The M2A™  Capsule should be ingested only in the
presence of authorized personnel. The patient should be
instructed not to let his/her relatives, neighbors or
acquaintances use the M2A™ Capsule.

•  This device has not been tested in pediatric population
(children 18 and below) and safety in young children is
unknown.
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PrecautionsPrecautionsPrecautionsPrecautions
A precaution indicates a condition that may damage the
equipment.

Precautions

•  USA Federal law restricts this device to sale by or on the
order of a physician.

•  Make sure that only trained personnel familiar with all of
the Given® Diagnostic Imaging System operating
procedures use the system.

•  Use the system only with components purchased from
Given® Imaging Ltd. Use of other components can void
the system’s warranty and may damage it.

•  When dispensing the M2A™ Capsule use the Capsule’s
holder.

•  To ensure proper imaging acquisition, verify the
following:

•  The patient has fasted for a period of 8 hours
prior to the M2A™ Capsule ingestion.

•  The Battery Pack is fully charged.

•  The Sensor Array is properly attached to the
patient’s body.



Overview

Given Imaging Ltd. 13

Adverse EventsAdverse EventsAdverse EventsAdverse Events
In patients with strictures of the gastrointestinal tract, the
M2A™ Capsule can potentially cause intestinal obstruction
resulting in the need for hospitalization and surgery. The use
of the M2A™ Capsule in patients with strictures of the
gastrointestinal tract is contraindicated.

Based on the experience gained so far, there is no adverse
event related to the proper use of the Given® Diagnostic
Imaging System.
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System LabelingSystem LabelingSystem LabelingSystem Labeling
The following table lists the labels attached to various
components of the Given® Diagnostic Imaging System.

Labeling Explanation

The M2A™ Capsule should be stored and used at a
distance from any powerful magnetic fields such as the
one created by an MRI.

The M2A™ Capsule is intended for single use only.

Attention! Consult the documentation provided with the
Given® Diagnostic Imaging System.

Class II equipment

Type BF equipment

FCC compliance

.

!

2
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System SpecificationsSystem SpecificationsSystem SpecificationsSystem Specifications
Note:

Specifications are subject to change without prior notice and without
any obligation to users on the part of the manufacturer.

M2A™ Capsule
Properties

Dimensions Length: 26mm
Diameter: 11mm

Weight 3.7 gr

Physical

Material Biocompatible plastic

Illumination 4 white light emitting diodes

Field of View 1400

Effective Visibility Distance: 3 cm

Magnification 1:8

Optical

Min. Detectable
Object

Less than 0.1mm

Sampling Rate 2 fps

Operating Time 7 ± 1hours

Mechanical Safety Passed 50 kg bite test

Chemical Safety Resistant to dissolution in pH=2
to pH=8

Battery Type Silver Oxide batteries

Operating
Temperature

20 - 45C0

Operational

Storage Temperature 0 - 50C0
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Data Recorder
Software Proprietary firmware

Recording time Up to 10 hours

Weight 305 gr

Battery type External, nickel-metal, 6V, 6500mAH

Battery Pack weight 912gr

Sensor Array 8 flat 40 mm diameter flexible PCB

Operating
Temperature

5 - 50C0

Storage Temperature -40 - 70C0

Shielding Shiledex® Supra, from Less EMF Inc.

RAPID™ Application Software
Software RAPID™ proprietary

Languages English/French/German/Italian/Spanish

Data export JPEG Images, AVI Movies, HTML Reports

Displayed data Images, Timebar and other diagnostic data.

Event marker Annotated thumbnails

Viewing rate 1-25 fps

 REMOVE!!!
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About this ManualAbout this ManualAbout this ManualAbout this Manual
This manual guides you through the use of the Given®
Diagnostic Imaging System. It instructs you on how to
connect, and use the system.

The manual is comprised of the following chapters:

Chapter 1: Given® Diagnostic Imaging System  –
describes the Given® Diagnostic Imaging System,
indications and contraindications, System specifications and
this Manual.

Chapter 2: System Setup – instructs you on how to set up
the Given® Diagnostic Imaging System.

Chapter 3: Getting to Know the RAPID™ Application  –
describes and instructs you on how to use the RAPID™
Application.

Chapter 4: Performing Capsule Endoscopy – instructs you
on how to prepare and check in the patient, deploy the
Receiving set and dispense the M2A™ Capsule. The chapter
also includes a troubleshooting section to guide you on how
to cope with various potential difficulties.
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Conventions
Menu, dialog box, tab and button names and options are
bolded and begin with uppercase letters. For example: Click
Save or select the Save All option.

Convention Explanation

<Space bar> Keyboard keys

File > Open Open the File menu and select the Open
option.

An important note

Bulleted List A one step procedure or a list of items.

•  Click Open.

Numbered List A multistep procedure. You need to
perform the procedure step by step
according to the order of the steps.

A warning

!
A precaution
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Contacting Given® ImagingContacting Given® ImagingContacting Given® ImagingContacting Given® Imaging
Information and Technical support for the RAPID™
Application and other system components is available from:

Company Headquarters Europe

Given Imaging Limited
POB 258
Yokneam, Israel 20682
Tel: +972-4-909-7777
Fax: +972-4-959-2466
info@givenimaging.com

North America Australia & New Zealand

Given Imaging Inc.
Oakbrook Technology Center
5555 Oakbrook Parkway, #
355
Norcross, GA 30093
Tel: 770-662-0870
       1-800-GIVENGI
Fax: 770-662-0510
infousa@givenimaging.com

Given Imaging
Unit 4, 277 Lane Cove Road
North Ryde, 2113, NSW,
Australia
Postal: Box 8, 293 Lane Cove
Road
North Ryde, NSW, 2113,
Tel: 0419 144 836
infoaus@givenimaging.com

Worldwide Support

support@givenimaging.com
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Chapter Two

System Setup

Before Your System ArrivesBefore Your System ArrivesBefore Your System ArrivesBefore Your System Arrives
Before the Given® Diagnostic Imaging System arrives in
your clinic prepare the following:

•  Five outlets: an outlet for the computer, monitor, power
supply, printer and an outlet for the charger.

Note:
You may use a multiple outlet.

•  Space for placing the system components: a computer,
monitor and a printer.

•  Space next to the Workstation for the Connection Box
and its wiring (about 8-12 inches, 20-30 cm) and for the
Data Recorder.

•  A storage space protected from any powerful
electromagnetic source for storing the M2A™ Capsule
10-Pak box.
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Connecting the SystemConnecting the SystemConnecting the SystemConnecting the System
This section describes the various connectors and cables of
the Given® Diagnostic Imaging System and instructs you on
how to connect the system.

Items to Connect
Following is a list of items you need to connect in order to
setup the Given® Diagnostic Imaging System:

•  RAPID™ Workstation

•  Monitor

•  Keyboard

•  Intel Mouse with Thumbwheel

•  Printer

•  Connection Box

•  Connection Box Power Supply

•  Data Recorder

•  Battery Pack

•  Telephone Connection

•  9-pin Male-Female Cable

•  9-pin Female-Female Cable

•  LAN Network Cable
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Connecting the Workstation
Use the back panel of the workstation for connecting the
monitor, keyboard, mouse, printer, LAN cable, modem, and
the Connection Box according to the scheme below:

Workstation  Backpanel

Printer Backpanel

2

USB

LAN
Network
Socket

Parallel/Printer Port

Serial (com)
Port 1

Serial (com)
Port 2

Keyboard
Mouse

Telephone
Line

Monitor Backpanel

Monitor
Modem
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The following table lists the connectors of the Workstation
back panel:

Connector Explanation

Power cord Connects the Workstation to the electric socket.

Keyboard Connects the keyboard to the Workstation.

Mouse Connects the mouse to the Workstation.

Monitor Connects the monitor to the Workstation.

Parallel Port Connects the Workstation to the printer.

USB Port Connects the Workstation to the printer, alternative to
Parallel Port.

LAN Connects the Workstation to the Connection Box to transfer
data from the Recorder to the Workstation and vice versa.

COM Connects the Workstation to the Connection Box.

Modem Connects the Workstation to a phone line.
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! To connect the workstation

1. Connect the IntelliMouse (Intel Mouse w/Thumbwheel))
cable to the Mouse connector.

2. Connect the Keyboard cable to the Keyboard connector.

3. Insert the LAN cable to the LAN connector.

Note:
The LAN cable is a special cable and cannot be replaced by a
standard LAN cable

4. Connect the Monitor cable to the Monitor connector.

5. Insert the Modem cable to the Modem connector and the
other jack phone connector of the Modem cable to the
phone outlet.

6. Connect the printer to the LPT connector or to the USB
connector, according to your printer connection cable.

7. Connect the Connection Box cable to COM 1.

8. Connect the Power cable of the monitor to the electric
socket.

9. Connect the Power cable of the Workstation to the
electric socket.
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Connecting the Connection Box
The Connection Box connects between the Workstation and
the Data Recorder.

The following table lists the connectors and indicators of the
Connection Box.

Connector/Indicator Explanation

9-pin Male connector Connects the Connection Box to the
Workstation with a 9-pin Female-Female cable

LAN connector Connects the Connection Box to the
Workstation with the LAN cable.

Power Supply Connects the Connection Box to the electric
socket

9-pin Female connector Connects the Connection Box to the recorder
with a 9-pin Male-Female cable.

Control LED Indicates that the Connection Box is connected
to the electric socket and is operating.

Workstation  Backpanel

2

Connection
Box

USB

LAN
Network
Socket

Parallel/Printer Port

Serial (com)
Port 1

Serial (com)
Port 2

Keyboard
Mouse

Network Cable
9 Pin Female-Female

Monitor
Modem

Power
Supply



System Setup

Given Imaging Ltd. 26

! To connect the Connection Box
1. Connect the 9-pin Male connector of the Connection Box

to the serial Com 1 of the Workstation with the 9-pin
Female-Female connection cable.

2. Connect the LAN cable to the LAN connector of the
Connection Box.

3. Connect the Connection Box to the Power supply.

4. Connect the Power supply to the electric socket.

5. Verify that the Control LED is on.

6. To connect the Recorder cable to the Connection Box,
connect the Male connector of the Recorder cable to the
Female connector of the Connection Box.

Note:
Connect the Recorder to the Connection Box only when
instructed to do so.



Given® Diagnostic Imaging System User’s Manual

Given Imaging Ltd.27

System Setup Scheme

Once you have finished connecting the Given® Diagnostic Imaging System, use the
following figure to verify the various connections.

Workstation  Backpanel

Printer Backpanel

2

Connection
Box

USB

LAN
Network
Socket

Parallel/Printer Port

Serial (com)
Port 1

Serial (com)
Port 2

Keyboard
Mouse

Network Cable9 Pin Female-Female

Telephone
Line

Monitor Backpanel

Monitor
Modem

Data
Recorder

9 Pin Male-Female

Power
Supply
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Chapter Three

Getting to Know RAPID™

Running the RAPID™ ApplicationRunning the RAPID™ ApplicationRunning the RAPID™ ApplicationRunning the RAPID™ Application
The RAPID™ Application software complies with the
conventions of Windows® operating system applications
conventions. However, various functions of the Windows
operating system are disables or modified to enable the
proper function of the RAPID™ Application..

During its operation, the RAPID™ Application writes files
and reads files from pre-defined locations on the RAPID™
Workstation hard disks.  Handle files only through the
RAPID™ Application and not by using the Windows
Explorer application. Do not change directory and file names.

Note:
The directory and file names should not be modified unless
under instructions from Given® Imaging technical support.

There are two hard disks in the RAPID™ Workstation. It
allows a total separation of RAPID™ Application software
from RAPID™ Application data. The RAPID™ Application
data is always written to disk E. Raw data downloaded from
the Data Recorder is written to the Recorder data directory
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while PRR data is written to Patient Rapid Report directory .
Data in these subdirectories should never be meddled with.

Before using the RAPID™ Application, you should create a
“User” subdirectory on drive E:\. Whenever he saves images
as files, use the “User” subdirectory. To copy files from the
RAPID™ Workstation use only the “User” subdirectory.

Running the RAPID™ Application is very easy and simple.
All you need to do is to double-click the RAPID™
Application icon that appears on the Workstation desktop.

! To run the program

1. Turn on the computer. The Windows desktop appears

2. Double click the RAPID™ Application icon.

The RAPID™ Application is running and the main
screen appears.

Selecting a Language
You can change the language of the RAPID™ Application.
By default, the RAPID™ Application language is English.
You can change it to either one of the following languages:

•  French •  Spanish •  German

For the language change to take effect, you have to restart the
RAPID™ Application.

! To change the language

1. Select Tools > Options.
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The Options window appears:

2. Open the Language drop-down list and select the desired
language.

3. Click OK.

4. Select File > Exit option to close the application.

5. Double click the RAPID™ Application icon to re-run the
program.

The RAPID™ Application is running with the language
of your choice.

Changing Display Settings
The RAPID™ Application is supplied with a default
Automatic display setting. With this setting, the RAPID™

Click here
to select a
language

Automatic

E:\rdata

E:\trials
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Application Main Screen has a resolution of 480x640 pixels.
This setting enables a clear view of the PRR movie.

You can change the display settings of the RAPID™
Application to reduce the size of the RAPID™ Main Screen.
For the display setting change to take effect, you have to
restart the RAPID™ Application.

! To apply specific display settings

1. Select Tools > Option.

The Options window appears.

2. Open the Display Settings drop down list and select
None.

3. Click OK.

4. Select File > Exit option to close the RAPID™ Application.

Click here
to select
display
settings

Automatic

E:\rdata

E:\trials
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5. Double click the RAPID™ Application icon.

Changing the Units
You can set the unit of measure for the measurements that
you type in dialog boxes. By default, the RAPID™
Application is using centimeters and kilograms. You can set
the unit of measure to inches and pound.

! To change the unit of measure

1. Select Tools > Options.

The Options window appears:

Click here to
select the
unit of
measure

E:\rdata

E:\trials

Automatic
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2. Open the Measurement System drop-down list and
select the desired measurement system.

3. Click OK.

The RAPID™ Application is running with the unit of
measure of your choice.

Main ScreenMain ScreenMain ScreenMain Screen
The RAPID™ Main Screen enables you to watch the PRR
movies and to diagnose irregularities in the gastrointestinal
tract. The following sections introduce you to the various
sections of the RAPID™ Main Screen and guide you
through the various available menu options.

Thumbnail
section

Video
section

Timebar
section

Displays
patient
details

Main screen
menus

Control buttonsIndicates the time of the
current image
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The RAPID™ Main screen is comprised of the following
sections:

•  Title bar

•  Menu section.

•  Video section

•  Thumbnail section

•  Timebar section
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Title Bar
The title bar displays the patient ID, initials and test date.
You entered these details during the Check-In process and
they were derived from the recorder during download.

Main Screen Menus
The drop-down menus of the RAPID™ Main Screen enable
you to use the various options available through the menus.
The following tables list the various menus and their options.
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File Menu

The File menu enables you to open or to save the PRR
movies and groups of thumbnails and to quit the RAPID™
Application.

Option Explanation

Open Enables you to select a PRR movie of
previous examinations.

Save Video As Saves the video under a different file name.
However, while watching the movie, the
name of the movie as derived from the
recorder appears in the Title bar.

Open Thumbnail Opens a selected file of thumbnails.

Save Thumbnails As Saves a selection of thumbnails as a GRML
file. The file name is comprised of the
movie name from which you created the
reproductions with the extension
TN.GRML.

Print Screen Creates a printout of the RAPID Main
Screen with the current display.

Print Setup Opens the standard Print window.

File list Displays a list of the last 7 files you opened.

Exit Quits the RAPID™ Application.
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Video Menu

The Video menu enables you to control the PRR movie.

Option Explanation

Step Forwards Moves forward to the proceeding frame.

Step Backwards Moves backward to the previous frame.

Play Forwards Starts the movie.

Play Backwards Plays the movie backward.

Pause Temporarily stops the movie presentation.

Restart Restarts the movie.

End Moves the PRR movie to the last frame.

Go To Frame Moves the movie to a frame that matches a
specific time indication.

Capture
Thumbnail

Duplicates a frame along with 100 adjacent
images, 50 before and 50 after the thumbnail.
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Online Menu

The Online menu enables you to check in a patient and to
download and construct a PRR movie.

Option Explanation

Patient
Check-In

Opens the Recorder Initialization screen.

Recorder
Download

Opens the Recorder Download screen.

Service This option is enabled only for an authorized
Given® technician.

Tools

The Tools menu allows you to change the RAPID™
Application interface and to set the source and target path
prior to the download.

Option Explanation

Options Defines the RAPID™ Application interface
language, movie speed, Data Recorder directory
and the Patient RAPID Report directory prior to
the download.

Help Provides information on the RAPID™
Application version. It also enables you to print
the Patient Instructions for Undergoing Capsule
Endoscopy and the RAPID™ Application User’s
Manual.
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Video Section
The Video section includes the presentation area and the
Control Buttons. The Control Buttons are located at the
bottom of the Video section and they allow you to do the
following:

•  Set the projection rate

•  Play/stop the movie

•  Move backwards or forwards frame by frame

•  Move to the last frame

•  Rewind the movie

•  Create thumbnails.

The Video section also displays the exact time of each frame
that is currently projected, as derived from the Recorder.

Thumbnail Section
The Thumbnail section presents images from the movie, and
enables you to annotate the snap shots. For further
information, refer to Thumbnail Section on page 60.

Timebar Section
The Timebar section is synchronized with the PRR movie
and it displays the time in relation to the frame currently
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presented in the Video section. In addition it presents the
time of any thumbnail. For further information, refer to
Timebar on page 68.
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Patient Check-InPatient Check-InPatient Check-InPatient Check-In
The RAPID™ Application enables you to check in the
patient who is intending to undergo the Capsule Endoscopy.

The checking in process includes the following:

•  Patient Registration – filling in the Registration
computerized form.

•  Recorder Initialization – downloading patient details to
the Recorder.

•  Disconnecting the Recorder.

! To check in a patient

1. Select Online > Patient Check-In.

The following screen appears guiding you through
connecting the Recorder.
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2. Follow the instructions on the Recorder Initialization
screen:

Verify that the Connection Box is connected to the
computer.

Verify that the power supply is connected to the electric
socket.

Verify that the Connection Box is connected to the power
supply.

Verify that the Recorder is NOT connected to the
Connection Box.

Note:
Connect the Recorder to the Connection Box only when
instructed to do so.

3. Click Yes.

The Add New Patient window appears.
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4. Under Patient Initials enter the information as follows:

In F, enter the first letter of the patient’s first name.

In L1, enter the first letter of the patient’s last name.

In L2, enter the second letter of the patient’s last name.

5. Under ID, enter the number of patient in the clinical
protocol.

Enter
patient’s
details

Enter
protocol
number and
date of test

Messages
area

Click to
initialize the
Recorder

Click to
cancel
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6. Open the Gender drop-down list and select the required
gender.

7. Under Birth Date, click the arrow and select the required
date of birth.

8. Open the Physique drop-down list and select either
skinny, normal, stocky or potbelly. Use the following
figure:

skinnyskinny stockystockynormalnormal potbelliedpotbellied

9. Under Protocol Number, enter the code of the clinical
trial protocol, you have been assigned by Given®
Imaging Limited, Division of Medical Affairs.

10. Under Test Date, enter the date of the test.

11. Click Check-In Patient.

In the Message area, a message appears asking you to
connect the Data Recorder to the Data Recorder cable.

12. Connect the Data Recorder to the Data Recorder cable.
Connect the 9-pin Female connector of the Data
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Recorder cable to the 9-pin Male connector of the Data
Recorder.

In the Message area, a message appears notifying you
that the Recorder initialization starts. The details you
entered during the patient registration are saved in the
Data Recorder directory and are downloaded to the Data
Recorder.
Upon completion, a message appears notifying you that
the Data Recorder initialization is complete.

Once the initialization process is complete a message
appears asking you to disconnect the Data Recorder.

13. Disconnect the Recorder from the Data Recorder cable.
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Creating a MovieCreating a MovieCreating a MovieCreating a Movie
Once you open the RAPID™ Application Main Screen and
you wish to watch a PRR movie, perform either one of the
following:

•  Create a movie.

•  Select and watch an existing movie.

Creating a PRR Movie
To create a movie, you need to download raw data from the
Recorder to the workstation. This process is comprised of
two stages:

•  Defining Data Recorder and Patient RAPID Report
directories.

•  Connecting the Recorder to the workstation.

Defining Directories

Recorder data directory - Define a directory for saving the
downloaded raw data. The default path is:
E:\rdata.

Patient Rapid Report directory - Define a path for saving the
processed data, i.e., the PRR movie. The default path is:
E:\trials.
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! To define the directories

1. Select Tools > Options.

The Options window appears:

2. The default Recorder Data directory is:
E:\ rdata. You should not change this setting unless
instructed so by Given® Imaging technical support.
To change the setting, click Modify and define the path
of your choice.

3. The default Patient RAPID Report is:
E:\trials. You should not change this setting unless
instructed so by Given® Imaging technical support.
To change the setting, click Modify and define the path
of your choice.

4. Click OK to apply the changes and to close the Options
window.

Define
here a
directory

Define
here a
directory

Click to
modify the

default
Input or
Output
path

Automatic

E:\rdata

E:\trials
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Note:
The Data Recorder requires a shared \rdata directory in order
to be able to download data to the workstation. This directory
should not be modified unless under instructions from
Given® Imaging technical support.

Connecting the Recorder and Downloading
Once you have defined directories for saving the downloaded
and the processed data, you can connect the Recorder and
download the raw data. The RAPID™ Application guides
you on how to connect the Recorder to the workstation. All
you need to do is to follow the instructions on the screen.

! To connect the recorder and start downloading

1. Select Online > Recorder Download option.

The Recorder Download window appears.
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2. Follow the instructions that appear on the Recorder
Download screen:

•  Verify that the Connection Box is connected to the
computer.

•  Verify that the power supply is connected to the
electric socket and to the Connection Box.

•  Verify that the Recorder in NOT connected to the
Connection Box.

3. Verify that all files in the Recorder data directory path
can be deleted. If they cannot be deleted, click Cancel
and re-define a shared \rdata Recorder data directory
path.

Note:
If, in the Recorder Download window, you click Cancel, the
download does not start and we advise you to define a new Data
Recorder directory.

4. To proceed, click OK.

A message appears asking you to connect the Data
Recorder to the Connection Box.

5. Connect the Data Recorder to the Recorder cable.

All raw data is being downloaded and simultaneously the
movie is being constructed and saved in the Patient
RAPID Report directory. During the construction, the
movie is projected in the Video section. Once the
download and the construction are complete, messages
appear respectively. The first frame of the movie appears
in the Video section.
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PRR Movie Name

Once the download process is complete, a new PRR movie
appears in the Output path you have defined. The movie file
name is comprised of the following components separated by
an underscore. The components are derived from the
Recorder during the download process:

•  A prefix (GI)

•  Patient’s initials

•  Examination date in the following format:
(YYYY/MM/DD)

•  Patient number

•  File extension (GTD)

For example, the file name GI_JBS_2000/12/06_12349.GTD is
a PRR movie of a patient number 12349 whose initails are JBS
and who went through the examination on 12/06/2000.

Precaution

!
Do not modify the files in the Patient RAPID report directory in
any way. Modification may result in loss of files.

Selecting an Existing Movie
The PRR movies are stored on the workstation in the
Video folder unless you choose to save them in another
location or under a different name.
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If you saved a movie under a different name, once you open
the file and watch the movie, the Title bar of the RAPID™
Main Screen displays the original movie name.

! To select a movie

1. In the RAPID™ Main Screen, select File > Open.

The Open window appears indicating the default
directory of the PRR movies.

2. The default directory of the PRR movie appears. If you
stored the video in another location, navigate to the desired
location.

3. Select the desired movie (*.gtd file) and click Open.
Once the movie is loaded the first frame appears in the
Video section and you can start watching the movie.

Guidelines for Watching the Movie
•  Verify that the display setting is Automatic. If not,

increase the RAPID™ Application resolution by setting
display setting to Automatic.

•  Dim the lights in the room.
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Watching the PRR Movie
The Video section enables you to watch the video captured
by the M2A™ Capsule during the examination. The PRR
movie is comprised of a series of single images and it can
present from 1 to 25 frames per second according to the
selected movie speed.

Primary Screening of the Movie
A primary screening of the movie is available while watching
the movie in Automatic speed mode. The Automatic speed
mode changes from a fast display rate to a slow rate
according to differences between consecutive images. When
the RAPID™ Application detects large differences between
adjacent images, it slows down the show rate to enable a
better look at the images.

The video presentation is synchronized with the Timebar
section. The Timebar progresses as the movie progresses.

To control the movie presentation, use the Control Buttons
located at the bottom of the Video section. The following
table lists the Control Buttons and the action each button
provides:
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Button Action

   Video speed Selects the projection rate. The available
rates are Automatic, Slow and Fast. The
Video Speed button changes according to
the selected speed.

 Restart Restarts the movie.

 Back Step Moves back to the previous frame.

 Play backward Plays the movie backward. If you click the
Play backward button, the Play forward
button changes to the Pause button while
the movie is playing.

 Play
forward

Plays the movie forward. If you click the
Play forward button, the Play backward
button changes to the Pause button while
the movie is playing.

 Pause

Stops the movie and a still picture appears.
The Pause button changes to a Play
button.

 Forward

Moves forward to the next image.
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Step

 End

Moves to the last frame of the movie.

 Capture
Thumbnail

Duplicates a frame. The duplication
immediately appears in the Thumbnail
section.

Selecting the PRR Movie Speed

There are three available modes of the PRR movie speed:
Automatic, Fast and Slow.

Automatic – automatically sets the display rate of the images
(between maximum 25 frames per second and a minimum 5
frames per second) according to the rate of change in
successive images. When the RAPID™ Application detects a
large difference between successive images, it slows down
the show rate to enable a careful examination of the pictures.

Fast – displays the movie in fast speed of 10 frames per
second (default). You can change the Fast rate by selecting
Tools | Options.

Slow – displays the movie in slow speed of 5 frames per
second (default).  You can change the Slow rate by selecting
Tools | Options.
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Setting the Fast and Slow Speed Rate

By default the fast speed is 10 frames per second and the
slow speed is 5 frames per second. The Options window
allows you to change the default settings of the Fast and
Slow modes.

! To change the default settings of Fast and Slow modes

1. Select Tools > Options.

2. The Options window appears.

3. Under Slow select the desired speed rate for the Slow
mode.

4. Under Fast select the desired speed rate for the Fast
mode.

The default speed mode of the movie is Automatic. You can
easily switch between the modes of speed.

! To select a speed mode

•  Click the Video Speed button to select the
desired speed mode. The letter that appears
on the Video Speed button indicates the
selected speed.

Set the
desired
speed
for the
Slow
mode

Set the
desired
speed
for the
Fast
mode

Automatic

E:\rdata

E:\trials
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Restarting the Movie

When you restart the movie, the time and frame indications
are automatically updated along with the Timebar.

! To restart the movie

•  Click the Restart button.

The PRR movie starts from the beginning and
the related features such as the Time and
Frame indications at the bottom of the Video
section automatically resets to zero.

Moving by Frames
You can move along the movie one frame forward or
backward, or to the last frame. While moving along the
movie, the related features are updated accordingly.

! To move by frames

•  To move one frame forward, click the
Forwards Step button.

The movie moves one frame forward.

•  To move one frame backward, click the Back
Step button.
The movie moves one frame backward.
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•  To move to the last frame in the PRR movie,
click the End button. The movie moves to the
last frame and the time indication at the bottom
of the Video section representing the end of
the study, is automatically updated.

Moving by Time Indication

You can move to a certain section of the movie by indicating
a time unit in the Time text box at the bottom of the Video
section. The movie automatically moves to the related section
of the movie.

! To move by time indication

1. In the Time text box at the bottom of the Video section,
type in the desired time in the following format:
HH:MM:SS.

2. Press the <Enter> key on your keyboard.
The movie automatically scrolls to the desired video
section and the Timebar is updated accordingly.
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Playing and Pausing

When you watch the movie and you would like to have a
longer look at one of the frames, you can temporarily stop the
projection of the movie.

! To Play/Pause the PRR Movie

To play the movie, click the Play forward button. The
movie is on. The Play backward button changes to the
Pause button.

To play the movie, click the Play backward button.
The movie is on. The Play forward button changes to the
Pause button.

To pause the movie, click the Play button.
The movie stops playing, the current frame appears as a
still picture and the Pause button changes to Play.
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Capturing an Image

When you capture a frame the following occurs:

•  The captured frame immediately appears at the bottom of
the Thumbnail section. The time indication derived from
the Recorder appears next to the captured frame in the
Thumbnail section.

•  An indication of the thumbnail appears in the Timebar
section of the RAPID™ Main screen.

! To capture a frame

1. 1. While the movie is playing, click Pause.

2. While the movie is still, click Capture Picture.

The selected frame appears with a time indication in the
Thumbnail section. An indication that a thumbnail was
created appears in the Timebar section.
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Thumbnail SectionThumbnail SectionThumbnail SectionThumbnail Section
The Thumbnail section displays images captured from the
PRR movie. Each reproduction appears in the Thumbnail
section with a time indication derived from the Recorder and
the first few words of the attached comment.

Once you have captured three images, a scroll bar appears
along the right side of the Thumbnail section. Use this
scrollbar to scroll through the captured images.

You can scroll through the thumbnails, save, delete and edit
any of the comments attached to the picture. You can also
move from a thumbnail to its exact location in the movie and
view the adjacent pictures. Any of these operations requires
the selection of a thumbnail.

Selecting a Thumbnail

You can select one, a few or all thumbnails. Follow the
provided instructions according to your needs.

! To select a thumbnail

•  Move the mouse pointer to the desired thumbnail and
click.

A blue square appears over the thumbnail.

A picture captured
from the movie

Time indication
derived from the
Recorder

The first word of
the attached
comment

Drag the scroll
bar to scroll
through the
thumbnails
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! To select several thumbnails

1. Select a thumbnail.

2. Move the mouse pointer to another frame you wish to
select and simultaneously click the mouse and the <Ctrl>
key of your keyboard; both selected thumbnails are
covered by a blue square.

3. Repeat step 2 until you selected all the desired pictures.
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! To select all thumbnails

1. Select the thumbnail at the top of the Thumbnail section.

2. Scroll to the last thumbnail and simultaneously click the
mouse and the <Shift> key of your keyboard; all
thumbnails are selected.

Scrolling through the Thumbnails
To scroll through the thumbnails, use the scroll bar located on
the right side of the Thumbnail section. The thumbnails are
arranged according to the sequence of capturing. The last
thumbnail appears at the bottom of the Thumbnail section.
Scrolling up reveals the more recent Thumbnails and
scrolling down reveals the previous ones.

! To scroll through the thumbnails

•  To observe a thumbnail previously captured, drag the
scroll bar toward the top of the main screen.

•  To view the most recently captured thumbnail, drag the
scroll bar toward the bottom of the main screen.
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Saving a Thumbnail

When you save a thumbnail, you actually save the thumbnail
AND a short movie. The movie is comprised of 100 adjacent
frames, 50 frames before and 50 frames after the selected
frame. To watch this short movie, use any Windows media
player, which is already installed on the Workstation.

The thumbnail is saved as a JPEG file and the short movie as
an AVI file. You need to select only the location for saving
the thumbnail. The RAPID™ Application automatically
saves the thumbnail as a *.jpg and an *.avi file in the selected
location.

The file name of the *.jpg and the *.avi file contains the same
components as the PRR movie they were captured from. For
further information, see PRR Movie Name on page 50.

! To save a thumbnail

1. Click a thumbnail to select it.

A blue square appears over the thumbnail.

2. Click the right mouse button.

A popup menu appears.

3. Select Save.

A window appears.

4. Select a folder for saving the thumbnail.

5. Click OK.
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The thumbnail is stored in the location of your choice as
a JPEG and an AVI file, and a message appears notifying
you that the operation is complete.

! To watch a the AVI movie

1. Open the Windows media player.

2. Navigate to the *.avi file of the thumbnail you wish to
examine.

3. Select the file.

4. Click OK.

The short movie of 100 images is running.

Saving a Group of Thumbnails
You can save a group of thumbnails as an independent file.
This file name contains all of the components of the PRR
movie file name with the extension tn.grml, i.e., GI_(patient
initials_examination date_patient number_tn.grml.

!  To save a group of thumbnails

1. From the File menu, select File > Save As Thumbnails
option.

The Save As window appears.

2. Select a folder for saving the thumbnails.

3. Click Save.

The group of thumbnails is saved as a file that its name is
identical to the PRR movie file name with the extension
tn.gml.
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Removing a Thumbnail

1. Select a thumbnail.

A blue square appears over the thumbnail.

2. Click the right mouse button.

A popup menu appears.

3. Select Delete; the reproduction disappears from the
Thumbnail section.

Creating or Editing a Comment

If you want to annotate a Thumbnail by entering a comment
or to edit a comment, do the following:

! To edit a comment

1. In the Thumbnail section, select a thumbnail.

2. Click the right mouse button; a menu appears.

3. Select Comment.

The Enter Comment window appears:

4. Type in a comment, or edit the existing comment.

Enter here
your
comment
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5. Click OK to save the changes and to close the Comment
window.

Reading the Comment
In the Thumbnail section, you can read the annotating
comment  of a thumbnail by placing the pointer of the mouse
on the beginning of the comment that appears below the
thumbnail.

Move the mouse
pointer to here to
view the complete
comment
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! To read the comment

•  Position the mouse pointer on the first word of the
comment located under the thumbnail.

The full comment appears and you can read it.

Moving from a Thumbnail to the Movie
If you wish to look at the images adjacent to the captured
one, you can move from the Thumbnail section to the Video
section. The PRR movie automatically displays the captured
frame to enable you to look at what preceded or followed the
captured frame.

! To move from a thumbnail to the movie

1. Select the desired thumbnail.

A blue square appears over the thumbnail.

2. Click the right mouse button.

A popup menu appears.

3. Select Go To; the movie automatically updates to display
the desired frame. Use the Forward and Backward Step
buttons to view the adjacent pictures.
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TimebarTimebarTimebarTimebar
The Timebar indicates the time as derived from the Recorder
during the movie projection. The Timebar is synchronized
with the movie and it moves along indicating the elapsed
time by changing the moving bar into light blue.

When you create a thumbnail, the Timebar section presents
the first word of the thumbnail annotation as the following
figure shows:

The section of the
movie you have
already watched

The section of the
movie you did not
watch

Thumbnails
that were
captured
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Scrolling Through the Movie
You can scroll through the movie by dragging the Timebar
up or down. The movie presentation is updated accordingly.

! To scroll through the movie

•  Drag the gray area of the Timebar up, to view the first
section of the movie and down to view the last section of
the movie.

The displayed PRR movie is updated accordingly.

Moving from Comment Indication to Frame
If you select a comment indication in the Timebar section the
movie automatically moves to the frame belonging to the
selected comment.

! To move from comment to frame

•  In the Timebar section, select a comment.

The comment indication appears in red, the mouse
pointer changes to red and the frame that the comment
refers to appears in the Video section.
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Chapter Four

Performing Capsule Endoscopy

Once the Given® Diagnostic Imaging System is connected
and ready for use and you are familiar with the system and
the RAPID™ Application, you can perform a Capsule
Endoscopy.

Performing a Capsule Endoscopy consists of the following:

•  Preparing the patient.

•  Preparing the examination set for the patient.

•  Checking in the patient.

•  Deploying the Data Recorder Set.

•  Dispensing the M2A™ Capsule.

•  Discharging the patient.

•  Receiving from the patient the Data Recorder, Sensor
Array, Battery Pack and Waist Belt.

•  Downloading data from the Data Recorder to the
Workstation and processing it to a PRR movie.



Capsule Endoscopy

Given Imaging Ltd. 71

Preparing the Patient
Once you have decided that the patient should undergo the
Capsule Endoscopy, inform the patient that the Capsule
Endoscopy involves the following:

•  Ingesting a small (the size of a large vitamin pill) Given®
Imaging M2A™ Capsule which will pass naturally
through the patient’s digestive system while taking
pictures of the intestine.

•  Attaching to the abdomen a Sensor Array. The images
captured by the M2A™ Capsule are transmitted to the
Sensor Array.

•  Wearing a belt around the waist during the examination,
which lasts approximately 8 hours. The belt contains a
Walkman®-like Given® Data Recorder which saves all
the images and shielding that ensures FCC compliance.
The belt must be worn at all times throughout the
procedure, a minimum of 8 hours.

•  Returning the Data Recorder set for further processing.

Inform the patient in writing and verbally that he/she needs to
do the following to achieve accurate results:

•  Abstain from food and drink for 8 hours prior to
undergoing the Capsule Endoscopy.

•  Male patients should shave their abdomen 6 inches above
and below the navel.

•  After ingesting the M2A™ Capsule, the patient should
not eat or drink for 2 hours. After 2 hours the patient may
drink water. After four hours the patient may have a light
snack. After the completion of the study, the patient may
return to his/her normal diet.
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•  After ingesting the M2A™ Capsule, the patient should
immediately contact the physician’s office if he/she has
any abdominal pain, nausea or vomiting.

•  After ingesting the M2A™ Capsule and until it is
excreted, the patient should not be near any source of
powerful electromagnetic fields such as one created near
an MRI device

•  During the examination, the patient should avoid any
strenuous physical activity. He/she should not bend or
stoop during the Capsule Endoscopy.

•  During the examination, the patient should check every
15 minutes that the green light at the top of the Data
Recorder is blinking. If it stops blinking during the first 6
hours of the examination, the patient should write down
the time and contact the physician’s office.

•  During the examination, the patient should not remove
the Data Recorder belt.

•  In the Event Form, the patient should write down the time
and the nature of any event such as eating, drinking and
unusual sensations. The patient will have to return this
form along with the examination set.

Note:
Before the patient leaves the clinic, you should give the patient
the Event Form along with a copy of the Patient Instructions for
Undergoing Capsule Endoscopy.



Capsule Endoscopy

Given Imaging Ltd. 73

Preparing Patient Examination Set
Verify that the Given® Diagnostic System is set up according
to the instructions provided in the Connecting the System on
page 21, and that you have the following equipment and
accessories:

•  M2A™ Capsule

•  Data Recorder

•  Sensor Array

•  Charged Battery Pack

•  Belt with belt extension, pouches and suspenders.

•  Application kit (10 adhesive sleeves, a Sensor Template,
two adhesive pads).

•  Marker

•  Razor

•  Disinfectant

•  Measuring tape

•  Scale

Checking In a Patient
The Check-In procedure is done through the RAPID™
Application. The procedure includes entering the patient’s
details and initializing the Data Recorder. Before you start
checking in the patient, verify the following:

•  The RAPID™ Workstation has a shared \rdata directory.
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•  The \rdata directory is defined as the Data Recorder
directory.

•  The RAPID™ Application is configured according to
your convenience, i.e., the language, screen settings and
measurement system.

•  The patient abstained from eating or drinking for the last
8 hours.

•  The patient did not take any medication in the last 2
hours.

•  The patient (if male) shaved the area of the abdomen 6
inches above and below the navel.

For further information, on how to check in, refer to the
Patient  chapter on page 41.

Deploying the Data Recorder Set
Deploying the Data Recorder Set includes the following:

•  Adjusting the Recorder-Battery belt.

•  Connecting belt components.

•  Attaching the Sensor Array to the patient.

•  Putting the belt on the patient.
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Adjusting the Recorder Battery Belt

The Recorder-Battery belt is an external belt that the patient
wears during the examination. It contains two pouches for
holding the Recorder and the Battery pack. It is important
that the belt fits the patient and the patient is comfortable
wearing the belt.

! To fit the Recorder-Battery belt

1. Ask the patient to stand up.

2. Place the belt around the patient’s waist.

3. Adjust the belt to fit the patient. For shorter patients, it
will be necessary to add the belt extension.

4. Make sure that the Battery Pack and the Recorder pouch
are at the patient’s waist as the following figure shows:

5. Adjust the suspenders to fit the patient.

6. Remove the belt.

7. Place the belt next to the Battery Pack and the Recorder.



Capsule Endoscopy

Given Imaging Ltd. 76

Connecting Belt Components

This section instructs you on how to connect the Battery Pack
to the Recorder and how to secure both Battery Pack and the
Data Recorder in their pouches.

Note:
Since fully charged batteries slowly discharge, use only a Battery
Pack you have just charged. For information on how to charge the
Battery Pack, refer to Charging the Battery Pack on page 88.

! To connect belt components

1. Place a recently fully charged Battery Pack in the battery
belt pouch.

2. To connect the Battery Pack to the Data Recorder,
connect the 9-pin Female connector of the Battery Pack
cable to the 9-pin Male connector of the Data Recorder.

3. Secure with the securing screws.

Note:
While connecting the Battery Pack to the Data Recorder, hold the
Data Recorder.

The Data Recorder green LED blinks, turns on and then
off. Once the recording starts the LED blinks at the
receiving rate.

4. Insert Data Recorder into the Data Recorder pouch, and
bring the Battery Pack cable out from the top opening of
the pouch. (See the following picture).
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5. Use the Velcro straps to secure the Data Recorder and
Battery Pack cable.

6. Fold the remaining length of the Battery Pack cable and
secure it with the Velcro flap along the back of the belt.

7. Put the belt aside until the patient is ready to wear it.

Warning
Do not connect the Data Recorder to the RAPID™
Workstation while Data Recorder is connected to the
Sensor Array  that is worn by the patient or while the Waist
Belt is in the belt being worn by the patient.
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Attaching the Sensor Array to the Patient

The Sensor Array is attached to the patient’s abdomen.

Use the Sensor Template to place each one to the eight
sensors of the Sensor Array in its correct location.
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Necessary equipment and accessories

The M2A™ Capsule 10-Pak of the Given® Diagnostic
Imaging System also includes the Sensor Application kit. The
kit contains the following items which are necessary for
deploying the Sensor Array:

Item Explanation

Sensor Template Helps you position each one of the eight
sensors in their proper location.

Marker Enables to mark the location of each sensor.

Adhesive
Sleeves

Holds each one of the eight sensors and
securely attaches each one of the sensors to its
place.

Adhesive Pads Enables secure attachment the Sensor Array
cable to the patient’s hip.

Disposable
Razor

Removes any hair from the abdomen.

Warning
Do not use the Sensor Array if it is torn or damaged.
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The template has 9 holes. Eight holes indicate the
recommended location of each one of the eight sensors and
the additional hole indicates the navel as a reference point.

Place the template on the patient’s abdomen and use the
marker to make a small dot at each location.

Remove the template and locate each sensor over the dot.
Securely attach the eight sensors to the patient’s body with
the adhesive sleeves. The adhesive sleeves are supplied with
the Sensor Application kit.

To secure the Sensor Array cable to the patient’s hip, use the
adhesive pads. The adhesive pads are supplied with the
Sensor Application kit.

Note:
Any object which comes in between the patient’s body and
the sensors, including hair or air, and any changes in the
sensors arrangement may interfere with the quality of the
data.

! To attach the Sensor Array

1. Insert each sensor into an adhesive sleeve. The sensor
markings (dots or “THIS SIDE UP”) should face away
from the patient and the adhesive side of the sleeve
should face the patient’s abdomen.
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2. To secure the sensor in the sleeve, remove the liner from
the adhesive line at the opening of the adhesive sleeve
and press both lips together.

3. Ask the patient to lie down and to expose his/her stomach
area down to the pubic bone.

4. If a male patient arrives unshaven, wipe the patient’s
abdomen with disinfectant and shave the abdomen 6
inches above and below the umbilicus (navel).

5. To mark the location of each sensor, place the Sensor
Template on the patient’s stomach with the drawing
facing up while using the navel as a reference point and
insert the marker into the holes. Mark the location of
each sensor.

6. Remove the Sensor Array Template from the patient and
keep it for reference until you complete the procedure.

7. Place the Sensor Array on the patient’s abdomen using as
a guideline the numbers on each sensor wire and the
numbers on the Sensor template. The Sensor Array
connector should be at the LEFT SIDE of the patient.

8. To attach each sensor, start with the rightmost sensor.
Remove the protective backing from its Adhesive Sleeve.
Secure the sensor to the patient’s abdomen so that the
hole at the center of the sleeve approximately overlaps
the marking on the patient’s abdomen.

9. Repeat step 1 - 8 for all sensors.
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10. To secure the Sensor Array cable to the left side of the
patient’s body, use the remaining adhesive pads as the
following scheme shows:

11. Instruct the patient to get dressed. The Sensor Array
connector and approximately 10 inches of cable should
remain outside of the patient’s clothes.

Putting the Belt on the Patient
Since you adjusted the belt, putting it on the patient is very
quick and simple.

! To put the belt on the patient

1. While the patient is standing, place the Recorder-Battery
Pack belt around the patient’s waist.

Note:
The Sensor Array connector and wire should dangle from above
the belt.

2. To connect the Sensor Array to the Recorder, insert the
Sensor Array 8-pins male connector to the 8-pins Female
connector at the top of the Recorder. Verify that the
protrusion of the Sensor Array connector is facing
outwards.
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3. Instruct the patient that the belt should not be removed
during the course of the examination for any reason, at
least 8 hours.
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Dispensing the M2A™ Capsule
Before dispensing the capsule ascertain that there is no other
M2A™ Capsule or other diagnostic capsule in the patient’s
gastrointestinal tract.

Note:
Verify that you read the Indications and Contraindications,
Warnings and Precautions in the Package Insert of the M2A™
Capsule or in chapter  one prior to dispensing the M2A™
Capsule.

! To dispense the M2A™ Capsule

1. Prepare a glass of water for the patient.

2. To activate the M2A™ Capsule, open the blister
containing the M2A™ Capsule.

3. Take the capsule with its holder out of the blister.

The capsule should start blinking

Note:
If for any reason, after activating the M2A™
Capsule by removing it from it’s blister, the patient
is not taking the M2A™ Capsule, it should be
deactivated by replacing it, in its holder, to the
blister. The capsule should stop blinking. If it does
not stop on your first attempt, turn the capsule in its
holder and replace in blister until blinking stops.

4. To verify that the capsule is operating, hold it in front of
the patient’s abdomen, close to the sensors.
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The Data Recorder LED starts blinking in green.

5. Instruct the patient to take the M2A™ Capsule out of its
holder.

6. Ask the patient to put the M2A™ Capsule in his/her
mouth, and to hold it under the tongue WITHOUT
INGESTING.

7. If after a short adjustment period, with the M2A™
Capsule in the patient’s mouth, the green light keeps on
blinking, ask the patient to ingest the capsule with a sip
of water.

Note:
The time elapsed between capsule activation and
ingestion should usually not exceed 1 minutes.

8. In the Event Form, write down the ingestion time of the
M2A™ Capsule.
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Discharging the Patient
Once the patient has ingested the M2A™ Capsule, the patient
may leave the clinic. The examination lasts as long as the
Data Recorder LED is blinking but not less than 6 hours
unless the M2A™ Capsule was excreted. Verify that the
patient knows how to behave during the examination.

! To discharge the patient

1. Verify that the patient has the Patient Instructions for
Undergoing Capsule Endoscopy, and a Capsule
Endoscopy Event Form.

2. Verify that the patient knows how to behave during the
examination:

•  The patient should avoid any physical activity
that involves sweating, bending or stooping.

•  The patient should avoid any source of powerful
electromagnetic fields such as one created near an
MRI device

•  The patient needs to abstain food for another 2 hours
after capsule ingestion. After 2 hours the patient may
drink water. Four hours after ingesting the capsule,
the patient may eat a light snack.

•  The patient may take usual prescribed medication
2 hours after ingesting the capsule.

•  The patient must not remove the Data Recorder
Waist Belt until 8 hours after the procedure has
begun.
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3. Ask the patient to check that the green LED of the Data
Recorder is blinking. If it stops blinking, the patient
should write down the time the patient noticed it. If it is
less than 6 hours since the ingestion of the Capsule, the
patient should immediately call your office.

4. Ask the patient to return to the clinic with the Data
Recorder, belt and Sensor Array after approximately 8
hours.

5. Instruct the patient whether, at the end of the
examination, he/she should take off the Data Recorder
and Sensor Array by him/her self or should return to the
clinic for removing the equipment.

6. If the patient should take off the Recorder and Sensor
Array by him/her self, verify that the patient understands
the instructions provided in the Patient Instructions for
Undergoing Capsule Endoscopy.

7. Discharge the patient.

Receiving the Examination Set
At the end of the examination, the patient should return to
your clinic and you may take off the examination set unless
the patient has already done this.

It is recommended to recharge the Battery Pack immediately
after return.

Note:
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The Battery Pack should be charged only with the charger
supplied by Given® Diagnostic Imaging System.

After removing the sensors from the adhesive sleeves, clean
them before storing.

! To receive the examination set

1. Disconnect the Data Recorder from the Battery Pack.

2. Take the Data Recorder and the Battery Pack out of the
belt.

Recharge the Battery Pack. For instructions refer to
Charging the Battery Pack on page 88.

3. Carefully remove adhesive sleeves from sensors. This
can be done easily by tearing them in the middle along
the perforation.

4. To clean the Sensor Array, wipe it lavishly with 90%
alcohol and let it air-dry for 20 minutes.

5. When the Sensor Array is dry, return it to the Carrying
Case in which they were supplied.

6. To download the data from the Data Recorder, refer to
Creating a PRR Movie on pate 46.

Charging the Battery Pack

Use only a fully charged Battery Pack. Since even fully
charged batteries discharge slowly, recharge the Battery Pack
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just before use. If a patient returns a Battery Pack at the end
of an examination and on the following day another
examination will take place, immediately recharge the
Battery Pack. Recharging a Battery Pack is an overnight
process.

Note:
The rechargeable Battery Pack lasts at least 2 years. After two
years of daily use or after 500 rechargings, it is recommended to
replace it.

Warning:
For charging the Battery Pack use only the Charger supplied
with the Given® Diagnostic Imaging System

! To recharge the Battery Pack

1. Connect the Charger male 9-pin connector to the Battery
Pack 9-pin Female connector.

2. Connect the Charger to the electric socket.

The Charger indicator is on.

When the Charger indicator blinks, the Battery Pack is
fully charged.

3. Unplug the Charger from the socket and from the Battery
Pack.
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4. Use the charged Battery Pack.
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TroubleshootingTroubleshootingTroubleshootingTroubleshooting
This section describes common problems you may encounter
when performing the Capsule Endoscopy, and instructs you
on how to cope and overcome these problems.

Note:
If you encountered a problem that is not mentioned in this section,
or you followed each step as advised in this section and the
problem persists, call Given® Imaging Limited technical support
Tel: +972-4-909-7706 .

Electrical Outage

PROBLEM

An electrical outage occurred during patient Check-In,
Recorder Initialization, or during download.

SOLUTION

Once electrical power has returned, restart the process.
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Data Recorder
The following section describes common problems you
might encounter while using the Data Recorder during the
Capsule Endoscopy.

Recorder Initialization

PROBLEM

During the Check-In process, after clicking Check-In, the
message Initializing Recorder stays on and the message
Initialization is complete does not appear.

SOLUTION

•  Check the Connection Box connection to the mains and
verify that the Connection Box LED is on.

•  Check the Recorder data directory:

•  Verify that the Recorder data directory is E:\rdata.

•  Verify that the \rdata directory is a shared directory.
Use Windows Explorer or My computer to do that.
If it is not a shared directory, select the E:\rdata
directory, right-click it and use the sharing sub-menu.

•  Check the Connection Box-Workstation connection:

•  Verify that the LAN cable is properly connected.

•  Check the connection of the 9-pin female-female cable
to the Workstation and to the Connection Box.

•  Verify computer name:
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My computer\properties\Network Identification\Full
computer name=RAPID. If not, change to RAPID and
restart the computer.

Data Recorder Operation

To check the Data Recorder operation, always verify that the
Data Recorder LED blinks as soon as you connect it to the
Battery Pack in the following blinking sequence:

The Data Recorder green LED blinks, turns on and then off.
Once the recording starts the LED blinks at the receiving rate.

PROBLEM #1

The LED of the Data Recorder does not blink upon
connecting the Battery Pack to the Data Recorder.

SOLUTION

•  Change the Battery Pack. If the problem persists:

•  Change the Data Recorder and repeat the Recorder
Initialization process.

•  Call technical support to report the faulty Data
Recorder.
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PROBLEM # 2

The Data Recorder LED does not blink while the M2A™
Capsule is held near the Sensor Array.

SOLUTION

1. Move the M2A™ Capsule away from the Sensor Array.

2. Disconnect the Battery Pack from the Data Recorder and
then reconnect them.

3. Verify that the Data Recorder LED blinks and then turns
off.

If it blinks and then turns off, bring the M2A™
Capsule close to the Sensor Array.

If the Data Recorder LED blinks, you may
proceed with the procedure of dispensing the
M2A™ Capsule.

If the Data Recorder LED does not blink, use
another M2A™ Capsule. Be sure to dispose of the
first capsule as per the instructions in this
manual.

If the Data Recorder LED does not blink, change the
Battery Pack.

If the Data Recorder LED blinks upon Battery
Pack connection, you may proceed with the
procedure of dispensing the M2A™ Capsule.

If the problem persists:

•  Change the Data Recorder and repeat the
Recorder Initialization process.
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•  Call technical support to report the faulty Data
recorder

PROBLEM #3

Data Recorder LED does not blink when the M2A™ Capsule
is in the patient’s mouth.

SOLUTION

1. Tell the patient to keep the Data Record belt on, and
instruct the patient to take the M2A™ Capsule out of
his/her mouth.

2. Hold the M2A™ Capsule next to a sensor attached to the
patient’s abdomen.

If the LED blinks, ask the patient to ingest the Capsule.

If not, replace the M2A™ Capsule and restart the
M2A™ Capsule Dispensing procedure as described on
page 84. Be sure to dispose of the first capsule as per
the instructions in this manual.

PROBLEM #4

The Data Recorder LED stops blinking during the
examination and more than 6 hours have passed since the
Capsule ingestion.

SOLUTION

A minimum of 6 hours is considered a successful
examination. However, it is recommended to try and continue
with the examination, and to check that the termination is not
due to a connection fault or to a Battery Pack premature
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depletion. (However, the belt must be worn in any event for a
minimum of 8 hours.). To check the connection and the
Battery Pack, perform the following:

•  Battery Pack and Data Recorder Connection

If there is a problem with the connection,

1. Reconnect the Battery Pack to the Recorder

2. Verify the blinking sequence of the Data
Recorder LED:

If the LED blinks upon Battery Pack connection
and then blinks according to the rate of
recording, continue with the examination.

If the LED does not blink upon connection of the
Battery Pack,, refer to Data Recorder Problem #1.

If the LED blinks upon Battery Pack connection
but does not start blinking according to the rate
of recording with an active capsule, the capsule’s
battery is depleted. Consider completing the
examination.

If the connection is intact,

1. Change Battery Pack.

2. Verify the Data Recorder LED blinking
sequence:

If the LED blinks according to the sequence
proceed with the examination.

If the LED blinks upon Battery Pack connection
but does not start blinking according to the rate
of recording with an active capsule, the capsule’s
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battery is depleted. Consider completing the
examination.

If the LED does not blink upon Battery Pack
connection according to the blinking sequence,
refer to Data Recorder Problem #1.

PROBLEM #5

The Data Recorder LED stops blinking during the
examination and less than 6 hours have passed since the
Capsule ingestion.

SOLUTION

•  Tell the patient to keep the Data Record belt on, and heck
the Battery Pack-Data Recorder connection.

If there is a problem with the connection:

1. Reconnect.

2. Verify the blinking sequence of the Data Recorder
LED:

If the LED blinks upon Battery Pack connection
and then blinks according to the rate of
recording, continue with the examination.

If the LED blinks upon Battery Pack connection
but does not blink when receiving data, the
M2A™ Capsule is defective.
Reschedule for another examination at a different
date after excretion of the M2A™ Capsule.
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If the LED does not blink upon Battery Pack
connection, refer to Data Recorder Problem #1. If
problem persists, reschedule for another examination
at a different date after excretion of the M2A™
Capsule, and contact Given® Imaging Limited
technical support.

If connection is intact:

1. Change Battery Pack.

2. Check blinking sequence of the Data Recorder LED:

If the blinking sequence is correct, proceed with
the examination and discharge the patient.

If the LED blinks, turns on and then off, but does
not blink according to the receiving rate,
reschedule for another examination at a different
date after excretion of the M2A™ Capsule.

If the LED does not blink upon Battery Pack
connection, refer to Data Recorder Problem #1. If
problem persists, reschedule for another examination
at a different date after excretion of the M2A™
Capsule, and contact Given® Imaging Limited
technical support.
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Data Recorder Download

PROBLEM

The download does not start and the Please Wait message
constantly appears.

SOLUTION

•  Check the connection of the Connection Box to the
electric socket and verify that the Connection Box LED is
on.

•  Check Data Recorder directory:

•  Verify that the Data Recorder directory is \rdata.

•  Verify that the \rdata directory is a shared directory.
Use Windows Explorer or My computer.

•  Check the Connection Box-Workstation connection:

•  Verify that the LAN cable is properly connected.

•  Check the connection of the 9-pin female cable to
the Workstation and to the Connection Box.

•  If all above are OK and the problem persists, call
Given® Diagnostic Imaging System technical
support.
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Sensor Array

Sensor Array Condition

PROBLEM

The Sensor Array you use is worn or torn.

SOLUTION

Use another Sensor Array supplied by Given® Imaging
Limited. Do not use a torn or a worn Sensor Array.

Sensor Location

PROBLEM

You applied a sensor to the wrong location.

SOLUTION

1. Remove the sensor from its location.

2. Carefully, take the sensor out of the adhesive sleeve.

3. Insert the sensor in a new adhesive sleeve.

4. To secure the sensor in the adhesive sleeve, remove the
liner from the adhesive area at the opening of the
adhesive sleeve and press the two lips together.

5. Reapply to correct location.
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M2A™ Capsule
PROBLEM

The M2A™ Capsule does not blink when removed from its
blister.

SOLUTION

Replace the M2A™ Capsule with another M2A™ Capsule,
and discard the defective capsule.
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